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Introduction

Conventions Used in this Document
This document uses the following conventions:

e The names of windows, fields, and other features displayed by the software are shown in bold
type.

e Information you enter into the software is in bold type, as in the following example: Enter
Miscellaneous in the Amount Type box.

e Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key
names indicates that you should press both keys at the same time; for example, SHIFT + TAB.

e The names of buttons you can click with your mouse are enclosed in bold type; for example, [OK]
and [Post].

Helpful information to make your experience better.

0 [V

NOTE: This symbol draws your attention to information of particular interest such as information
not included in steps.

? CAUTION: This symbol draws your attention to information that is important because it can help
you avoid a costly or time-consuming error.

*

.~ I IMPORTANT: This symbol draws your attention to information that is of critical importance.
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Introduction

MyAssistant Installation Guide

This document steps through installing and configuring Sage 300 CRE MyAssistant 18.1.5. This process
consists of the following steps:

1. Installing the MyAssistant Server software on your Sage 300 CRE Server.
2. Configuring the MyAssistant Server software by completing the MyAssistant Configuration Wizard.

3. Installing MyAssistant on the desktop computers or Terminal/Citrix Servers where MyAssistant will be
used.

4. Activating and configuring the MyAssistant software for each Windows User that will use MyAssistant.

Installing and configuring the MyAssistant server should take approximately 1 hour. Installing each
MyAssistant workstation should take approximately 10 minutes.

Please refer to the Frequently Asked Questions section at the end of the Install guide for answers to common
installation and configuration questions.

CAUTION: If you are upgrading from a previous version of MyAssistant, please refer to the
MyAssistant Upgrade Guide for upgrade instructions. Please contact Sage Support if you need a copy
of the Sage 300 MyAssistant Upgrade Guide.
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Introduction

Before You Install

1.

Identify the computer where the MyAssistant Server software will be installed. It's recommended
that the MyAssistant Server is installed on your Sage 300 CRE server. If not an option, the
MyAssistant Server software can be installed on another server with a compatible version of
Sage 300 CRE installed.

Confirm the computer where the MyAssistant Server software is installed meets the minimum Sage
300 CRE MyAssistant Hardware & Software requirements and that it is left on 24/7.

Identify a Sage 300 CRE user and password that MyAssistant will use to access Sage 300 CRE data.
This user should have sufficient security privileges to access the Sage 300 CRE data you want
MyAssistant to monitor.

IMPORTANT: Confirm that the password for this Sage 300 CRE user is set to never expire.

4.

Select the email account/address that MyAssistant will use to send Notification email messages. You
will need the name or IP address for the outgoing mail server, as well as the user name and
password.

Identify the computers (i.e. desktops or Citrix/Terminal servers) where a MyAssistant Workstation
install will need to be performed. A MyAssistant Workstation install needs to be performed on
machines (other than the MA Server) where users will be setting up Tasks, viewing Sage information
via Live Tile, running MyAssistant Tasks and/or working with their Notifications in the Sage Desktop.

If your network is monitored by a proxy server, you will need to provide a proxy server user and
password to activate MyAssistant.

NOTE: Each MyAssistant activation is licensed to a Windows User on a specified machine. Each user

will need to activate the software. This applies to MyAssistant on standalone workstations, Citrix or
Terminal Servers.

The MyAssistant Product Key determines the features available to each user:
e The MyAssistant Server product key is for activating the MyAssistant Server.

e The MyAssistant Designer product key provides access to setup features such as creating

and scheduling MyAssistant Tasks and defining security. This key provides all of the
functionality of the MyAssistant application.

e The MyAssistant product key allows users to run Tasks and send emails via the
MyAssistant application, as well as view and work with Notifications using the Sage Desktop
and MyAssistant Live Tile.

Verify you can start the Sage 300 CRE software on each computer, including the server where the
MyAssistant Server will be installed.

If you are using the Sage 300 CRE Service Management application, open Service Management and
run a report to ensure that an ODBC connection to the SM database has been established.

Ensure the latest Microsoft Windows and Microsoft Office updates have been installed, including on
the server. We recommend installing all High Priority updates at a minimum.
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Restart the server where the MyAssistant Server will be installed prior to beginning. This will
complete any Windows or other software updates that require a restart to complete.

10. Confirm that Windows User Access Control (UAC) is turned off on ALL machines where MyAssistant
will be installed. UAC can be turned off by performing the following:

e Open the Windows registry and navigate to the following path:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System

o Double click on “EnableLUA” and change the value to “0”, then click “OK”
e Reboot the computer

UAC needs to remain off on any machine where the MyAssistant Server is installed. This includes
when the MyAssistant Server is installed on the Terminal/Citrix server.

IMPORTANT: Turn off any antivirus and firewall software on the server where the MyAssistant Server
software will be installed. It can be turned on again after the MyAssistant Server software is installed and
configured, but exceptions will need to be added (see Chapter 5 for more details).

11. Sage 300 CRE MyAssistant installs the following software:

e Microsoft SQL Server 2012 Express (On the Server Only)
e Sage 300 CRE MyAssistant software

Removing any of the above will disable the Sage 300 CRE MyAssistant software.

IMPORTANT: Confirm that the Windows users installing and configuring MyAssistant have access
to the following locations:
e On the MyAssistant Server: Access to Program Files, Program Data, and can write to the
Local Machine hive of the Windows Registry.
e On a MyAssistant Workstation: Access to Program Files, Program Data, and can write to the
Current User hive of the Windows Registry.
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Hardware and Software Compatibility

Minimum Hardware Requirements
The following are the minimum hardware requirements for Sage 300 CRE MyAssistant.

MyAssistant Workstation Installation
e 2 GB of available memory
e 1 GB of available disk space
e Video card capable of 1024 x 768 resolution

MyAssistant Server Installation
e 4 GB of available memory
e 10 GB of available disk space
e Video card capable of 1024 x 768 resolution

Supported Software
Sage 300 CRE MyAssistant 18.1.5 must be installed on a computer running one of the following
operating systems:

e Windows Server 2008 R2
e Windows Server 2012 R2
e Windows Server 2016

e  Windows 7

e Windows 8.1

e Windows 10

If possible, install the MyAssistant Server software on your Sage 300 CRE server. If not possible, the
MyAssistant server software can be installed on another machine running one of the Windows Server
operating systems listed above.

MyAssistant must be installed on a computer with a constant connection to the Internet and access to the
MyAssistant Activation Server.

MyAssistant version 18.1.5 is compatible with Sage 300 Construction and Real Estate v18.2.
Sage 300 CRE Security must be enabled to send reports listed on a Reports menu in a supported Sage

300 CRE application. This includes reports designed with either the Sage 300 CRE Report Designer or
Crystal Reports applications.

Email Server Compatibility
MyAssistant is compatible with most SMTP-compatible email servers. MyAssistant has been tested with
Microsoft Exchange, Office 365, and Gmail.

Installation Guide Page 7



Introduction

Support and Training

Telephone Support
When you would like to speak to a customer support analyst directly, call us at 800-551-8307. Telephone
support is available Monday through Friday from 6 a.m. to 5 p.m. Pacific Time with the following
exceptions:

e Every Thursday from 2 p.m. to 3 p.m. Pacific time (closed for customer support staff meetings)

e Standard United States holidays

e Quarterly company meetings

Sage Customer Portal
You may log on to the Sage Customer Portal at:
https://customers.sagenorthamerica.com/irj/portal/anonymous/login

The portal provides access to the following services:

o Knowledgebase: Find answers to your questions, access downloads, and subscribe to your
favorite articles. This service is available online 24/7.

e Live Chat: Chat online with a customer support analyst, a great option for quick questions. Chat
hours are Monday through Friday from 6 a.m. to 3 p.m. Pacific Time, with the same exceptions as
telephone support.

¢ Online Support Request: If you have a question or an issue that is not urgent, you can submit an
online support ticket. A customer support analyst will contact you during regular telephone
support hours.

Training

Sage University

Sage University offers both recorded and live training sessions. Visit SageU.com for currently available
and upcoming classes.

How to access MyAssistant training options in Sage University:
1. Enter www.SageU.com in your web address bar
2. Click [Customer Training] and select your Sage 300 Product from the list
3. Inthe page that opens, click [Product Training] on the left side of the screen
Click [MyAssistant] in the list that opened
Select either [Realtime Learning] or [Replay Leaning] and review the available options in each

SN

How to access Complimentary MyAssistant Training in Sage University:
1. Enter www.SageU.com in your web address bar
2. Click [Customer Training] and select your Sage 300 Product from the list
3. Click [Complimentary Training] on the left side of the screen
4. Review the list of complimentary classes for a MyAssistant option

MyAssistant YouTube Channel
The MyAssistant YouTube channel offers a variety of MyAssistant training videos. Subscribe to the
MyAssistant YouTube channel to be notified when new videos are added.

How to access the MyAssistant YouTube channel:
1. Enter www.YouTube.com/MyAssistantTraining into a web browser
2. The channel will open with all available videos listed
3. Click on a video to watch

Local Business Partner
Contact your local Business Partner to learn what types of MyAssistant training they can provide.
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Server Installation

Chapter 1 — Installing MyAssistant Server

Perform the following to initiate the MyAssistant Server installation:

1.

2.

Log on to the server as a Windows user that has Administrator permissions.

Confirm this operating environment meets the Sage 300 CRE MyAssistant hardware and
software requirements outlined in the Before You Install section of this document.

Confirm that you have closed all applications and disabled any User Access Control (UAC), anti-
virus or Firewall software that may be running.

Confirm that all system software updates/installations have been completed by restarting the
server prior to installing MyAssistant. After restarting, log back into the server as a Windows user
with Administrator permissions.

Using the link provided by Sage Software, download the MyAssistant installation files and save
the .ZIP file to a folder on your machine. Consider saving the .ZIP file to a shared folder so it is
accessible from any workstations where MyAssistant will be installed.

Begin the MyAssistant Server Installation:

a) Open the location of the downloaded MyAssistant Installation files.

b) Unzip the files to the same location as the .ZIP file (either a local or shared folder).

¢) Open the folder of unzipped MyAssistant installation files and double click autorun.hta

The Sage 300 CRE MyAssistant Installation hub will open.

Sage 300

Construction and Real Estate

MyAssistant

Version 18.1.5
» View Installation Guide.

» Install Server.

» Install Workstation.

| SageCRE.com | Exit I

Click [Install Server] to begin installing the MyAssistant Server software.
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Server Installation

Step 1 — MyAssistant Server Installation

The MyAssistant Installation Wizard opens after selecting the type of install.

m MyAssistant - Setup Server E

Welcome o the MyAssistant Server Instaler

Welcome

Thiz wizard will guide you through the Mybzsistant installation process. Y'ou may be
azked to restart pour spstem after inztalling prerequisites,

& Prerequisites

@ Mydssistant

Before continuing installation, pleaze cloze all applications [zuch as Microzoft Outlool,
Yiruz Scanners, and Spuware Detectors), since they can interfers with the My Assistant
installation,

Mewut » Cancel

Click [Next] to continue.
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Server Installation

Step 2 — MyAssistant License Agreement

You must accept the License Agreement below to use the Sage 300 CRE MyAssistant software. A complete
copy of the Innovative Software Design License Agreement is provided with the MyAssistant installation files.

B Myassistant - Setup Server

License Terms for MyAssistant Server

License Terms IMPORTANT - RFEAD CAREFULLY: This Software ﬂ
License Agreement (the “Agreement”™) 15 a legal agreement

between you - either an ndividual or a single entity - the

“Licensee™ and Innovatve Software Design, Inc

FISD™, This Agreement apples to the computer

software product, i machine readable form, that

accompanies  this  Agreement  (the  “Software™),

documentation and related services. YOU AGEEE ToO

BE BOUND BY THE TEEMS OF THIS AGREENNT

BEY DOING ONE OFE MORE OF THE

FOLLLOWING, CF. ATLOWING OF.

ATTTHORIZING A THIRD PARTY TO DO IT FOR

YO Ay CLICKEING “T ACCEPT THE TEEMS IN

THE LICENSE AGREEMENT, B) INSTALLING THE

SOFTWARE OR C) TUSING THE SOFTWARE. IF

TOU DO NOT AGREE TO BELEGATLY BOTUND BY

THIS AGEEEMENT, I IT°S ENTIRETY, YOI DO

NMOT HAVE A4 LICENZE TO TTSE THE SOFTWARE

AND SHOULD NOT INSTALL, COPY, OR TISE THE =l

[ accept the terms in the license agreement

Mest = | Cancel |

If you agree to the terms of the License Agreement, check the | accept the terms in the license agreement
checkbox and click [Next] to continue.
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Server Installation

Step 3 — Prerequisites for MyAssistant Server

This window is only displayed if any MyAssistant prerequisites are missing. Green check marks indicate
prerequisites that are already installed, while the blue circle indicates those that are missing.

NOTE: Only check the “Do not install SQL Server Express” box if you have separately purchased,
installed and will be using a full version of the Microsoft SQL Server database. Do not check this box if
you are unsure if you have a full version of Microsoft SQL Server installed. By checking this box, you are
taking full responsibility for the installation, setup, and maintenance of the SQL Server instance used with
MyAssistant.

Given the system resource requirements of Microsoft SQL Server Express, installing more than two SQL
Server Express instances on the same machine will likely result in performance issues. To prevent this,
you can install the MyAssistant Server software on another server if it meets the hardware and software
requirements specified in the “Before You Begin” section of this document.

m MyAssistant - Setup Server E

Prerequisites for Mylssistant Server

Mydssistant requires the following items to be installed before continuing. Items with a

Install Prerequisites checkmark are already installed on your spstem:

“windows installer Update
Windows NET 3.5
Windows NET 4.0

L I O

SGL Server Express

[~ Do nat install SAL Server Express

Only check this bax if yau have installed pour own instance of SEL Server.
Please read the Installation Guids for more informaticn,

Next > | Cancel

Click [Next] to begin the install of the necessary prerequisite software.

IMPORTANT: The SQL Server install can take up to 20 minutes. Please be patient, and do not
cancel the SQL install.

NOTE: MyAssistant requires the following settings when using a full version of SQL Server:

- “Mixed Mode” Authentication - Enabled TCP/IP protocol - A static port and no

- Dynamic ports removed - A SQL Server User name and Password*

* |f using the SQL instance installed by MyAssistant, a user name and password will automatically be
created. Changing or creating a new SQL user hame or password means you take full responsibility
for the installation, setup, and maintenance of the SQL Server instance used with MyAssistant.
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Server Installation

Step 4 — MyAssistant Software

In this step you determine where the MyAssistant program files will be installed on your server.

m MyAssistant - Setup Server E

My Assistant Server

The default location where the Mydzsistant program files will be inztalled
to iz C:hProgram Fileshlnnovative Software Designhbdy desistants, oo
may uze the Browze button to specify a different location on your local

. computer.
Ingtall Mpdesiztant

Select a location to install Mydszistant;

II::'\F'mgram Files [#86]M\ nnovative Software Designi\My Assistant

Browse... |

Installing Mydssiztant application...

Mewut » | Cancel I

Accept the default location or click [Browse] to specify a different location.

Click [Next] to install the MyAssistant software.
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Server Installation

Step 5 - You Have Completed Installing the MyAssistant Server

Congratulations, you have completed installing MyAssistant Server software.

m MyAssistant - Setup Server E

ol have completed instaling MyAssistant Server

Congratulations! You have finizhed installng the Mydssistant Server. The
Mud zziztant Server must be activated and configured to run. To achivate the
zerver, run the Mpdssistant Configuration Manager.

Finished

Click [Finish] to close the wizard.

NOTE: You must complete the Configuration Manager on the server before installing MyAssistant
on any Workstations.
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Server Installation

Start the MyAssistant Configuration Manager

After clicking Finish, you will be prompted to start the MyAssistant Configuration Manager.

MyAssistant - Setup Server |

'6' Your MyAssistant Server needs to be configured before it can be
l used.

Do waou wank to run the My Assistant Configuration Manager now?

Click [Yes]. Continue to Chapter 2 to walk through configuring the MyAssistant Server.
If you do not configure your MyAssistant Server at this time, you can do it later by running the MyAssistant

Configuration Manager. This can be opened with the icon installed on your desktop or by going to Start > All
Programs > MyAssistant > MyAssistant Configuration Manager.
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Additional Settings

Chapter 2 — MyAssistant Server Configuration

This chapter walks through configuring the MyAssistant Server software. This process must be done before
installing MyAssistant on any Workstations.

Read this section carefully

MyAssistant Server Configuration steps:

1. Activate the software.

2.
3.

Select a list of prebuilt Tasks (Construction or Real Estate) to create with your MyAssistant database.

Enter the Sage 300 CRE username and password that MyAssistant will use to access Sage 300 CRE
data.

Specify the Sage 300 CRE data folders MyAssistant will monitor.

Configure server options, including preferences on daily email summaries, error notifications and
service settings for running Tasks and sending emails with Notifications.

NOTE: Configuring the MyAssistant Server will take approximately 10 minutes.

Considerations before you begin:

1.

If you use Service Management in the Sage 300 Construction and Real Estate software, open the
module and run a report. This will verify your connection to the ODBC driver.

Confirm that the password associated with the Sage 300 CRE user that MyAssistant will use to
access the Sage 300 CRE database does not expire.

Any of the configuration settings except the prebuilt Tasks list can be changed after initial setup.
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Additional Settings

Step 1 - Welcome

If the MyAssistant Configuration Wizard doesn’t start, it can be opened using the desktop icon or by following
this path: Start > All Programs > MyAssistant > MyAssistant Configuration Manager.

@ My Assistant Server Canfiguration Wizard = = ER
| T | Welcome To The Myhssistant Server 2
Product Activation You may need the following information to configure the Myfssistant Server:

MvAssistant Database Conneckion

MyAssistant Datahase » Your Myfssiskant customer number and Activation codes

Sags 300 CRE Data Folders » The Windows password for the Adminiskrator user,
Maotification E-Mail Accaunt

. » B Sage 300 CRE Operatar ID and passward that MyAssiskant will use to access Sage 300 CRE data,
Server Opkions

» The email account which MyAssistant will use to send email messages,

| Show Advanced Options C

Mexk = Cancel

Check the box next to Show Advanced Options if:
e You are using a Web Proxy Server.
e You are using a full version of the Microsoft SQL Server database.
e You will define the Microsoft SQL Server credentials that will be used access MyAssistant data.

? CAUTION: Changing the SQL Server user name and password should only be done by someone
with in-depth knowledge of SQL Server. Changing the credentials to something other than the default
could break the connection to the MyAssistant database, and means you take full responsibility for the
setup and maintenance of the SQL Server instance used with MyAssistant.
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Additional Settings

Step 2 — Product Activation

In this step you will activate the MyAssistant Server and enter any Web Proxy Settings.

@ My Assistant Server Configuration Wizard = gl
welcome Product Activation 2]
| Product Ackivation | Enter your custormer nurnber and server product key to activate Myfssistant Server,
MyAssistant Database Connection Customer Murnber
My &ssistant Database Server Product Key
Sage 300 CRE Data Folders | Use Web Proxy Server

‘Wweb Prowy Settings
Web Proxy Address:

Motification E-Mail Account

Server Opkions
User Marme:

Password:

Darmair:

< Back Cancel

Your customer number and server product key were provided with the MyAssistant software — if you don’t
have this information, please contact Sage Support. Enter the following information in their respective fields:

e Customer number — Enter your Sage customer number.

e Product Key — Enter your MyAssistant Server product key.

NOTE: The Web Proxy Server checkbox will only appear if you selected Show Advanced Options in
the Welcome step (Step 1).

If you use a Web Proxy Server, check the box displayed under the Server Product Key field and
provide the requested information.

After the MyAssistant Server has been activated, click [Next] to continue.
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Step 3 — Database Connection

NOTE: This step will only be available if you click [Show Advanced Options] in the Welcome step

or are using a version of Microsoft SQL Server Express, Standard or Enterprise other than the instance of
Microsoft SQL Server 2012 Express installed by MyAssistant.

@ Myfssistant Server Configuration Wizard = 3l
Welcome Connect to the MyAssistant Database e
Product Ackivation Lize the fields below to enter the computer name where the S0L Server database

is installed and to create a SOL Server user,

Myhssistant Database Connection

Enter the cormputer that the database is located at:
Mdssistant Database server Name SERVER]

Sage 300 CRE Data Folders Create a username and password For MyAssistant ko access

the SOL Server:
Motification E-Mail Account

User Marne My Bssiskant

Server Opkions

PaSSWDrd bt b nd b R i

Re-enter Pasoword: | ek

Advanced Connection Settings

Insktance name: | 15D
Database name:

Port number: 45312

< Back Mext = Cancel

This step gives you access to the server name, SQL Server credentials, and SQL Instance and Port
Number MyAssistant is using to connect to the Database.

? CAUTION: If using the SQL instance installed by MyAssistant, a user name and password will
automatically be created. Making changes in this step can break the connection to the MyAssistant
database. These fields should only be changed by someone with in-depth knowledge of SQL Server.
Changing or creating a new SQL user name or password means you take full responsibility for the
installation, setup, and maintenance of the SQL Server instance used with MyAssistant.

Click [Next] to continue.
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Step 4 — Create the MyAssistant Database

Select the type of prebuilt MyAssistant Tasks to install. This selection is permanent and cannot be
changed for the database being created.

@ Iwdssiskant Server Configuration Wizard s
welcame My fssistant Database e
Product Activation Please select a list of preconfigured Myassistant Tasks to create the Myassistant

database,

MyAssiskant Database Connection

: Canskruction Tasks |-
My Assistant Database
Construction Tasks

Sage 300 CRE Data Folders Real Estate Tasks

Motification E-Mail Account

Server Opkions

< Back Mext = Cancel

Once a set of prebuilt Tasks is selected, click [Next] to create the database.

NOTE: Check the documents in the MyAssistant install files for the Construction and Real Estate
Prebuilt Task lists. Use these lists to determine which set of prebuilt Tasks you want to install.
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Step 5 - Sage 300 CRE Data Folders

This step is used to specify the Sage 300 CRE data folder(s) that MyAssistant will monitor. Multiple Sage 300
CRE data folders can be chosen.

@ Iy Assistant Server Configuration Wizard = Ol
Welcome Define Sage 200 CRE Data Folders (2]
Product Activation Enter a Sage 300 CRE operator and password that My&ssistant will use to access Sage

300 CRE data,

My Assiskant Database Connection
Sage 300 CRE User:

My&ssistant Database Sage 300 CRE
Sage 300 CRE Data Folders passward: Show charackers
Motification E-Mail Account Click, "add Data Folder" bo select the Sage 300 CRE data Folders you would like to maonitar with
Myhssistant,
Server Opkions
Sage 300 CRE Folder Location Marme
[ i IProgramDatal S AGE TIMBERLINE OFFICE Dl S E Tz (ot R e g s g R 4 [ela]

4 *

Import Sage Database Customizations Add Data Folder

< Back Mext = Cancel

Sage 300 CRE User — Enter the Sage 300 CRE user name MyAssistant will use to access the Sage 300
CRE database when Tasks are run.

IMPORTANT: Using a Sage 300 CRE user with a password that does not expire is highly
recommended. Also confirm the Sage 300 CRE user entered has access and privileges to all Sage records
you want to monitor in MyAssistant.

Sage 300 CRE password — Enter the password associated with the Sage user entered.

Specify the Sage 300 CRE Data Folder(s) — Click in the open field below Sage 300 Data Folder Location.
Click [...] to open a window listing all available Sage 300 Data folders and their file paths. Select the data
folder you want and click [OK]. Repeat in the next empty row down to add as many additional data folders as
desired. MyAssistant will automatically create an ODBC data connection (Windows DSN) for each Sage 300
CRE data folder specified.
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| * IMPORTANT: If the MyAssistant Server is not on the same computer as the Sage 300 CRE Server, try
to select data folders that use UNC paths. If you must use a mapped drive, the MyAssistant Drive Mapper will
need to be set up — please see Chapter 5 for more information on the MyAssistant Drive Mapper.

Click [Next] to continue.

Import Sage Database Customizations

If you select one data folder, MyAssistant automatically imports the Sage Database Customizations for that
folder when you click [Next]. If more than one folder is selected, clicking [Next] opens a window asking you to
specify which data folder’s database customizations to import. Importing database customizations can be run
as often as necessary, and accessed any time after the initial installation via the MyAssistant Configuration
Manager. Please note only one folder’s Sage database customizations can be in the MyAssistant database at
a given time.

@ Myissistant Server Configuration Wizard =gl
Welcome Define Sage 300 CRE Data Folders a
Product Activation Enter a Sage 300 CRE operator and password that MyAssistant will use to access Sage

300 CRE data.

Myfssistant Database Connection
Sage 300 CRE User:

Myhssistant Database Sage 300 CRE

Sage 300 CRE Data Folders password: Show characters

Motification E-Mail Account Click "ndd Data Folder” ko select the Sage 300 CRE data folders wou would like to monitor with
Myfssiskant,
Server Cptions

Sage 300 CRE Folder Location

C:\ProgramDatalSAGEVTIMBERLIME OFFICE\Data)...  [REGEyERes gl dgNla s aly]

#dd Data Folder

Irmporting cuskor Figlds: 12% completed. ..

< Back Mexk =

The connections to the Sage 300 CRE data folders will be tested when you click [Next].

[E NOTE: When you create a custom field or change a field’s description in Sage 300 CRE, you must
import Sage database customizations for MyAssistant to recognize the change. Again, only one Sage data
folder’s customizations will be recognized in MyAssistant at a time. Importing another Sage data folder’s
customizations will overwrite the previous folder’s customizations in MyAssistant.
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Step 6 — Notification E-Mail Account

MyAssistant lets you send emails with Notifications and attachments to specified people when specific criteria
are met. In this step you will specify the email account and Mail Server Settings used to send emails.

@ My Assistant Server Configuration Wizard = 3
I Metfication E-Mail Account
Product Activation ze the following to specify the e-rmail account from which notification e-rail

rmessages wil be sent on this server,

Myissistant Database Connection -
Fram Marne: My Assiskant

My#ssistant Database Erar E-mail Address:

Saqge 300 CRE Data Folders

P 5 IMail Server Settings
Motification E-Mail Account

) Qukgoing Mail Server:
Server Options
Username:
Password:

Show characters

This server requires an encrypted S50 connection

< Back. Mt = Cancel

From Name — Enter the name that email messages will come from. This name is displayed in the recipient’s
inbox.

From E-mail Address — Enter the email address from which email messages will be sent.

Outgoing Mail Server — MyAssistant requires an Outgoing Mail Server to send emails. If using Microsoft
Exchange, enter the name of the Exchange server. If Microsoft Exchange is not being used, the email server
is determined by your Internet Service Provider (ISP). The outgoing email server used should be associated
with the From E-mail Address entered. Refer to the instructions on the following pages to determine the
name of your outgoing email server.

Username — Enter the user name to log on to the specified email account. Refer to the instructions on the
following pages to determine the user name for the email address entered in the From E-mail address field.

Password — Enter the password for the specified email account.

Check the box for This server requires an encrypted SSL connection if your email server requires a
secure connection.
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IMPORTANT: You may need to configure SMTP relays to allow the MyAssistant Server to send email
messages. Consult the administrator of your mail server to confirm your settings or configure your relays.

Determining Mail Settings in Outlook for Microsoft Office 365 and Outlook 2016

Perform the following to determine the outgoing mail server and user name for a specific email address when
using Outlook for Microsoft Office 365.

1. Log onto the machine as the Windows user that can send an email from the account/address
MyAssistant will use to send emails.

Start Microsoft Outlook.

Click on the File tab and select Account Settings.

In the dropdown menu that appears, click [Account Settings].

Select the email account that will be used in the Account List, then click [Change].

Enter the name displayed in the Mail Server field as your Outgoing Mail Server in MyAssistant.
Enter the user name displayed in the User Name field as your user name in MyAssistant.

Nogakwn

Change Account @

Server Settings
Enter the information that is required to connect to an Exchange ActiveSync service,

User Information

Your Mame: John Doe

E-mail Address: John.Doe@company.com
Server Information

Mail server: blu403-m.company.com

Logon Information

User Name: John.Doe@company.com

Password: ded et A

Offline Settings
Mail to keep offline: U All

- Back Mext = l [ Cancel
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Determining Mail Settings in Outlook 2013

Perform the following to determine the outgoing mail server and user name for a specified email address
when using Outlook 2013.

1. Log onto the machine as the Windows user that can send an email from the account/address
MyAssistant will use to send emails.

Start Microsoft Outlook.

Click on the File tab and select Account Settings.

In the dropdown menu that appears, click [Account Settings].

Select the email account that will be used in the Account List, then click [Change].

Enter the name displayed in the Microsoft Exchange Server or Outgoing Mail Server field as your
Outgoing Mail Server in MyAssistant.

Enter the user name displayed in the User Name field as your user name in MyAssistant.

ogakwn

~

i - N
Change Account Iﬁ

POP and IMAP Account Settings
Enter the mail server settings for your account.

User Information Test Account Settings

Your Mame: John Doe We recommend that you test your account to ensure that
the entries are correct.

Email Address: John.Doe@Company.com

Server Information

[ Test Account Settings ..

Account Type: POF3

. . W | Automatically test account settings when Next
Incoming mail server: pop3.company.com is clicked v = g

Qutgoing mail server (SMTFE | smtp,.company.com

Logon Information

User Name: John.Doe@company.com
Password: xnu******|
[V Remember password

|:| Reqguire logon using Secure Password Authentication

SPA]
[3PA) Maore Settings ...

[ MNext = ][ Cancel ]
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Determining Mail Settings in Outlook 2010

Perform the following to determine the outgoing mail server and user name for a specified email address
when using Outlook 2010.

1.

ogakwn

~

Log onto the machine as the Windows user that can send an email from the account/address
MyAssistant will use to send emails.

Start Microsoft Outlook.

Click on the File tab and select Account Settings.

In the dropdown menu that appears, click [Account Settings].

Select the email account that will be used in the Account List and click [Change].

Enter the name displayed in the Microsoft Exchange Server or Outgoing Mail Server field as your
Outgoing Mail Server in MyAssistant.

Enter the user name displayed in the User Name field as your user name in MyAssistant.

Change E-mail Account

Internet E-mail Settings
Each of these settings are required ta get wour e-mail account warking.

User Information Test Account Settings

Your Mame: 1ohn Doe After filling out the information on this screen, we
recommend vou test vour account by clicking the

E-mail Address: John. Dos@company . com button below. (Requires network connection)

Server Information

Test Account Setkings ...

Account Type:

Incoming mail server: PO . COMPAENY , Com
Cutgoing mail server (SMTREY: smtp. companry .com
Logon Information

Liser MName: John.Doe@company, com
Password: —

Remember passwiord

[ Require logon using Secure Password Authentication (SPAY Maore Setkings ...

[ Mexk = ][ Zancel ]
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Step 7 — Server Options

In the final step, you determine a variety of settings around the MyAssistant Server.

@ Mydssiskant Server Configuration ‘Wizard - X

Server Oplions 7]

‘Welcome

Product Activation Z .
Daily Summaries

MyAssistant Database Daily Summary can be used to send someane a list of natifications across multiple subjects (Tasks)
Sage 300 CRE Data Folders Deliver summary emails at: | 4:00 am -

Mokification E-Mail Account
Send Errors To

Server Options

Recipient narme:

Recipient email:

Browse, .,
Save Sage MyCommunicator Email Messages
Folder Location:
Automatically save email associated with MyCommunicator activity i

Running Tasks and Sending Service Settings

Determine the number of concurrent processes that will be used to run MyAssistant Tasks and Send emails,

Concurrent processes ko run Tasks LY B Task timeout in minukes 60 -
Concurrent processes bo send email 2|z Sending Timeout in minukes | 240 2
< Back. Firish Cancel

Daily Summaries: MyAssistant Daily Summary email messages are used to send each recipient their
Notifications across several Tasks in one email message. See the MyAssistant User Guide for more
information. The time entered here should be after all of your Tasks have finished running.

Send Errors To: The email address entered here is who to notify when MyAssistant encounters an error.
It is recommended to send error messages to the primary MyAssistant user.

Save MyCommunicator Email Messages:

Sage MyCommunicator for Outlook allows you to centrally track users’ email correspondence related to
your business. In addition to creating a record of business-related emails, a copy of the mail messages
can be saved and linked to your Sage data (e.g. Jobs, vendors, customers, etc.). To enable this function,
check the box in this section and click [Browse...] to select a folder location.

Running Tasks and Sending Service Settings:

MyAssistant runs Tasks, sends emails and updates Sage data with MyCommunicator via background
processes (i.e. Windows Services) on the server. These processes are now scalable to increase
performance, and can auto-correct in the event of a hang.
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These MyAssistant Services (named ISDAdminTaskService and ISDAdminSenderService) start other
processes named “TaskRunner*32,” which each take 30-50Mb of memory when idle. Many variables
affect the system resources used when Tasks run and emails are sent, including:
e The available server memory
e Disk drive performance
e Other server demands at the time the MyAssistant Tasks are run or emails are being generated.
For example, running Tasks at night may allow additional server resources to be dedicated to
MyAssistant.

Perform the following to determine the optimal number of processes:
e Complete the MyAssistant Server Configuration Wizard with the default settings and the
MyAssistant Workstation installation.
e Activate two MyAssistant Tasks you will regularly use.
Monitor the server memory usage and disk queue lengths when the Tasks are run concurrently.
Open the MyAssistant Configuration Manager and increase or decrease the number or processes
based on the results of this test and available server resources.

Click [Finish] to close the MyAssistant Server Configuration Wizard.

Once the Configuration Wizard has closed, the Server portion of the MyAssistant installation is complete.
Continue to Chapter 3 to install the MyAssistant Workstation.
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Chapter 3 — Installing MyAssistant Workstation

IMPORTANT: If you are installing on a Terminal or Citrix Server, please go to Chapter 6.

Before beginning the MyAssistant installation on your workstation, make sure you can open Sage 300 CRE
on the machine. If you use Service Management, also open Service Management and run a report to ensure
the ODBC connection to the SM database has been established.

Perform the following to install MyAssistant:
1. Log on to the machine that will be the Sage 300 MyAssistant Workstation as a Windows user that
has Administrator or unlimited permissions.

2. Confirm that you have closed all applications and disabled any anti-virus or Firewall software that
may be running.

3. Confirm that all system software updates/installations have been completed by restarting the
machine prior to installing MyAssistant.

4. Using the link provided by Sage Software, download the MyAssistant installation files and save
the .ZIP file to a folder on your machine. If accessible from the workstation, you can use the same
files that were used to install on the MyAssistant Server. Perform the following:

a) Open the location of the downloaded MyAssistant Installation files.
b) Unzip the files to a folder on the local drive on the machine.
c) Open the location of the unzipped MyAssistant installation files and double click autorun.hta

5. The Sage 300 CRE MyAssistant Installation hub will open:

Sage 300

Construction and Real Estate

MyAssistant

Version 18.1.5
» View Installation Guide.

» Install Server.

» Install Workstation.

sae

SageCRE.com I Exit I

Install Workstation — Click [Install Workstation] to begin installing the MyAssistant Workstation.
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Step 1 - Welcome

When you select Workstation Install in the MyAssistant splash screen, the Setup Workstation wizard will
appear.

mMynssistant - Setup Workstation E

Welcorme to the MyAssistant Installer

Welcome

Thiz waizard will quide you through the Mydsziztant installation process. vou
Install Prereqiusites may be azked to restart your spstem after installing prerequisites,

®  Prerequizites

®  Mydsziztant

Before continuing installation, please close all applications [such as Microzoft
Outlook, Wirug Scannersz, and Spuware Detectorz], since they can interfere
with the My Azzistant installation,

Meut » Cancel

Click [Next] to continue.
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Step 2 — MyAssistant License Agreement

Read and accept the Innovative Software Design End-User License Agreement. You must accept the
Innovative Software Design License Agreement to use the Sage 300 CRE MyAssistant software.

m Myhssistant - Setup Server

Licenze Terms

License Terms for MyAssistant Server

IMPORTANT - READ CAREFULLY: This Software
License Agreement (the “Agreement’™ 15 a legal agreement
between you - ether an mdmdual or a smgle entity - the
“Licensee™ and Innovative Software Design, Inc
CISD™. This Agreement applies to the computer
software product, i machine readable form, that
accomparges  thus Agreement  (the  “Sobtware™),
documentation and related services. YOUT AGREE TO
BEE BOUND BY THE TEEMS OF THIS AGREEMNT
BEY DOING ONE O©OFR MORE OF THE
FOLLLOWING, CE. ATLOWING OF.
ATUTHORIZING A THIRD PARTY TO DO IT FOR
YO Ay CLICKING “T ACCEFT THE TEEMS IIM
THE LICENSE AGREEMENT, B) INSTATLLING THE
SOFTWARE OR C) TSING THE SOFTWARE. IF
TOUT DO NOT AGREE TO BELEGALY BOUND BY
THIS AGEEEMENT, I IT°3 ENTIEETY, YOU DO
NOT HAVE 4 LICENSE TO TSE THE SOFTWARE
AND SHOULD NOT INSTALL, COPY, OR TISE THE

[ accept the terms in the license agreement

Memt

3

Cancel |

Click [Next] to continue.
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Step 3 — Prerequisites for MyAssistant Workstation

This window displays the prerequisite software that MyAssistant will install. The green check mark is beside
the software already installed on your machine. The blue circle is beside the software MyAssistant will need to
install. If all prerequisites are already installed, this step will be skipped.

Click [Next] to continue with the MyAssistant Workstation Install.
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Step 4 - Install the Software

In this step you will determine where the MyAssistant program files will be installed on your workstation.

m MyAssistant - Setup Workstation E

[V Assistant

The default location where the Modeziztant program files will be installed
to iz C:\Program Files\Innovative Software DesigniMy Assistanty, ¥ou
Inztall Prereqiuzites may uze the Browse button to zpecify a different location on your local

. compLter,
Inztall Mypdasistant

Select a location to ingtall Mudszsistant:

IE:'\F'mgram Files =BG  nnovative Software Designibdy desistant

Browse... |

Mewut » Cancel

Accept the default location or use the [Browse] button to specify a different location.

Click [Next] to install the MyAssistant software on the workstation.
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Step 5 - You Have Completed Installing MyAssistant

Congratulations, MyAssistant has successfully been installed on this machine. When launched for the first
time MyAssistant will ask you to provide some basic information to activate and connect to the

MyAssistant Server.

m MyAssistant - Setup Workstation E

You have completed instaling MyAssistant

o Congratulations! *rou have fimzhed installing Mydzziztant When you launch
Irestall Preregiusites bndzziztant far the firzt time pou will be azked to provide some bagic infarmation
to activate and connect to the Mydssistant Server.

Finizhed

Finish |

Click [Finish] to close the setup wizard.
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Chapter 4 — MyAssistant Workstation Configuration

CAUTION: Each MyAssistant activation is tied to a single Windows user on one computer. Make sure
that you are logged in as the correct Windows User prior to activating the MyAssistant software. Sometimes
this is not the same as the Administrator account used to install the MyAssistant Workstation.

After completing the MyAssistant Workstation installation, a MyAssistant shortcut is added to the desktop.
Each time MyAssistant is opened by a Windows user that has not previously activated the software, they will
be prompted to activate and specify their user-specific settings.

Configuring the MyAssistant Workstation will take approximately 5 minutes.

Step 1 — Welcome Screen

@ Iy Assistant User Configuration Wizard 1 =l rd

| Welcome To Myfhssistant L7

| Welcarme:

Product Activation ou may need to the following information to configure My Assistant;

Sage 300 CRE Data Folders

Your Settings o four Myfdssistant customer number and Activation codes

| Show Advanced Optians G

Mext =

If there is not a shortcut on the desktop, open MyAssistant using the following path:

Start Menu > All Programs > MyAssistant > MyAssistant
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Step 2 — Product Activation
MyAssistant must be activated to use it. A working internet connection is required to complete this step.
NOTE: The Web Proxy Settings will only be visible if you clicked [Show Advanced Options] in the

Welcome step and if you check Use Web Proxy Server. If you don’t know if you're using a Web Proxy
Server, it is recommended that you leave the box unchecked.

@ Mydssistant User Canfiguration Wizard = 3
Welcoms Product Activation 7
| Product Activation | Enter your custormer number and user product key to activate Myasssistant for Lser
Administrator on this computer, The MyAssistant product key determines the
Sage 300 CRE Data Folders My&ssistant features available to user Administrator on this computer,
Your Settings Customer Mumber innaovate

M Assistant Produck Key
| Use Web Prowy Server

‘WWeb Prowy Settings
Web Prowy Address;

User Mame:
Password:

Dramain:

Activate Later

< Back,

Customer Number — Enter your Sage customer number.

Product Key — Enter the Product Key that corresponds with the MyAssistant edition you would like to
activate.

MyAssistant Designer — MyAssistant Designer is the full version of MyAssistant. The MyAssistant
Designer provides the ability to create, activate and change Tasks; as well as run Tasks and view the
Notification logs.

MyAssistant — MyAssistant has the ability to run tasks on demand and view the Naotification log. This
version does not provide the option to create, activate or change tasks.

NOTE: Your customer number and product keys were provided with the MyAssistant installation
files. If you do not have this information, please contact Sage Support.
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Step 3 — Entering Sage 300 CRE Data Folder Information

The Sage 300 CRE Database Settings are used to connect to your Sage 300 CRE database from the
workstation.

@ IMyassiskant User Configuration Wizard = 3 3¢

Define Sage 300 CRE Data Folders @

Wwelcome

Praduct Ackivation Enter your Sage 300 CRE user name and password,

Sage 300 CRE Data Folders |

Sage 300 CRE User:

Your Settings Sage 300 CRE |

password:

|| shows characters

Click in the Sage 300 CRE Folder Location calumn to specify a data Folder, IF any Sage 300 CRE data folders
were prefilled verify the path,

Ignore Sage 300 CRE Folder Location ame
» [ C\ProgramDatal SAGEVTIMBERLINE OFFICE,... | Timberline Construction

<« Back Mexk = Cancel

Specify Sage 300 CRE data folder locations — The data folders specified during the MyAssistant server
setup will be listed in the grid. MyAssistant will automatically set up an ODBC data connection for each Sage
300 CRE data folder given the specified location\path. Click in the Sage 300 CRE Folder Location column and
then the ellipsis “...” button to select the appropriate path for each Sage 300 CRE data folder. (You may not
see all of your data folders, which is normal.)

Check the Ignore check box for any Sage 300 CRE data folders that should not be accessed on this
workstation.

Sage 300 CRE User and Password — If security is enabled in Sage 300 CRE, enter your Sage 300 user
and password. These will be used to look up the Sage 300 CRE reports available to attach to a Task; as
well as test conditions and formulas and preview MyAssistant Spreadsheet Templates.

Clicking Next will test each data folder connection with the Sage 300 CRE user and password entered.
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Step 4 — User Profile

Complete the Personal Information step with information for the Windows User on this machine.

@ Mydissiskant User Configuration YWizard - X

Weltome Your Personal Information

Product Activation Enter the person's name and e-mail address for the current Windows User.

Sage 300 CRE Data Folders

Your Settings Windows User: Adriniskrator

Your Mame:

Your E-mail Address:

+| Show Motifications in the Sage 300 CRE Desktop
o | Display Myassistant Alerts in the Swstem Tray

| Shows My Assistant Tile on the Deskiop

< Back Finish

Windows User — This field is automatically filled with the Windows user name that is currently logged on
to the computer.

Your Name — Enter the user’s name.
Email Address — Enter the user’'s email address.

Sage 300 CRE MyAssistant will start when you click [Finish].
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Chapter 5 — Additional Settings

Antivirus Exceptions

Sage 300 CRE MyAssistant can send emails when specified criteria are met. However, many common
antivirus, Internet filtering or Firewall products can block emails sent via MyAssistant if certain programs are
not added to specific exception lists.

If you are running antivirus or Internet filtering software, please add MyAssistant.exe, ISDAdminService.exe,
ReportRunner.exe, TaskRunner.exe and MyAssistantConfigurationManager.exe to the exceptions list
contained in the antivirus or Internet filtering software. This only needs to be done on the MyAssistant Server.

MyAssistant Drive Mapper Tool

If you use one or more Mapped Drives (e.g. drive letter “T:”) to access your Sage 300 CRE data or
Program Files, you need to install the MyAssistant Drive Mapper. The MyAssistant Drive Mapper is used
by the Windows Service that runs MyAssistant Tasks to access your Sage 300 CRE data or programs.

How do | know if I need to use the MyAssistant Drive Mapper?

The MyAssistant Drive Mapper needs to be used any time a mapped drive is used instead of a UNC path to
access Sage data or Program Files. There are several places to review to determine which drives, if any, will
need to be mapped using the MyAssistant Drive Mapper.

1. Log onto the Server where the MyAssistant Server software is installed
a. Open the Windows Registry
b. Navigate to HKEY_LOCAL_MACHINE\Software\(Wow6432node (if on a 64 bit
machine)\Timberline\General. If a mapped drive is used in any of the paths, you will need to
install the Drive Mapper.

2. Start a Sage 300 application.
a. Go to File > Open Company. If a mapped drive (e.g. “T:”) is used in the path / location of your
Sage data folder(s), the MyAssistant Drive Mapper will need to be installed.
b. Go to File > Company Settings > File Locations. You will need to install the MyAssistant Drive
Mapper if a mapped drive (e.g. “T:”) is in the listed for any Sage data files.

CAUTION: The MyAssistant Drive Mapper needs to be used any time a mapped drive is used to
access Sage data or Program Files. If you are using UNC paths, do not use the Drive Mapper tool.

Perform the following to install the MyAssistant Drive Mapper Tool:

1. Log on to the computer where the MyAssistant Server is installed using a Windows user that has
Administrator or Unlimited privileges.

2. Open the folder containing the MyAssistant Installation Files.

3. Using Windows Explorer, copy these two files from the Tools\DriveMapperCommand folder in the
MyAssistant installation files:

¢ InnovativeSoftwareDesign.MyAssistant.DriveMapperCommand.dll
e DriveMapperCommand.config

Place the above files in the following three locations. If you accepted the default location when
installing the MyAssistant software, these locations will be:

1. C:\Program Files\Innovative Software Design\My Assistant

2. C:\Program Files\Innovative Software Design\MyAssistant\SendService

3. C:\Program Files\Innovative Software Design\MyAssistant\TaskService
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4. Start the Windows Notepad application.
5. Click File > [Open], and select the DriveMapperCommand.config file from the folder that this file was
copied into. The contents of the file should be the following:

2 DriveMapperCommand.config - Notepad : El[z|
File Edit Formak Yiew Help

<DriveMappercontig>
<MappedDr ives
<DriveLetter>T</DriveLetter:
<UMCPath=" MAZHINENAMENTimbher 1inevataFolder < /UNCPat b
< Mappedorive:s
</Drivemappercontigs

6. Replace the value between the <DriveLetter> and </DrivelLetter> labels with the drive letter you use
to access your Sage 300 CRE data.

£ DriveMapperCommand.config - Notepad : E'E'
File Edit Farmat Yiew Help

<Drivemapperconfig:
<MappedDrives
<DriveLetters Tk /DriveLetters
<UMCPath="MACHIMNENAMEST imber 1inebataFolder </ UNCPaths
</MappedDr ives
</DriveMapperContigs
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7. Replace the value between <UNCPath> and </UNCPath> labels with the UNC path that the drive is
currently mapped to for this user.

I DriveMapperCommand.config - Notepad
File Edit Farmat Wiew Help

<DriveMapperConfigs
<Mappedbrives
<DriveLettersT< /Driveletters
<UNCPath>%1MACHINENAMEST imbher Tineshareshar enamef,/UNCPaths
k/Mappedhbrives
</DrivemapperConftig:

If you do not know the UNC path that the Sage 300 CRE drive is currently mapped as, open Windows
Explorer and click on Tools -> Map Network Drive. In the drive letter list, it will show how each drive is
mapped.

Map Metwork Drive E|

Windows can help wou connect ko a shared netwark folder
and assign a drive letker to the connection so that vou can

\” acress the Folder using My Compuker,
— e

e | Specify the drive letter For the connection and the Folder
khat wou want bo connect ko

Dirive: T \lteskserverishare W

Folder:

Browse, .,

ltestserverishare

Cancel

Z

i

b3

W

s

L _'
T |
St

R

Q

P:
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8. If you have different Sage 300 CRE Data folders on different mapped drives, you will need to map
multiple drives. To do this, add a <MappedDrive> section for each additional drive.

I DriveMapperCommand.config - Notepad

File Edit Format Wew Help

<Drivemappercontig:
<Mappedbrives

<briveLetter>U</DriveLetter:>

<UMCPathz“ \MATHIMNEMAMEST imber TinebataFolder < UNCPaths
<Mappedbrives
<Mappedbrives

<briveLetter U</ /DriveLetters

<UMCPath>“ MAZHIMNENAMEST imber 1inebataFolder < /UNCPath:
</Mappedbrive:s
</DriveMapperconfigs

Save your changes using the Save option on the File menu and close the Notepad application.
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Chapter 6 — Installing on a Terminal Server

? CAUTION: This chapter is written for clients who will be running the MyAssistant Server and at
least one MyAssistant User on a Terminal or Citrix Server.

What is Involved

Perform the following to install MyAssistant on a Terminal or Citrix Server:

Log onto the Server as a System Administrator

Run the MyAssistant Server Installation Wizard

Activate and configure the MyAssistant Server

Log onto the machine with the Windows credentials of the user who will run the software
Open the MyAssistant user Application

Activate and configure MyAssistant for the Windows user

ogakwnE

Before Installing
Before MyAssistant can be activated on any accounts other than the Administrator, permissions must be
given to specific files. The default paths have been provided below, but they may vary.

e C:\Program Data
e C:\Program Files\Innovative Software Design
OR
e C:\Program Files(x86)\Innovative Software Design

IMPORTANT: Permissions need to be given to these folders prior to activating any MyAssistant
users on this machine.

Installing the MyAssistant Server

Return to Chapters 1 and 2 for installing and configuring the MyAssistant Server. When you have
completed Chapter 2, return to this Chapter to activate the MyAssistant User Software on this Terminal or
Citrix Server.

Activating the MyAssistant Workstation
Once the MyAssistant Server is installed and activated, log onto the Terminal or Citrix Server as the
Windows user who will be using the MyAssistant software.

o If there is a MyAssistant icon on the desktop, double click to open the User Configuration

Manager.
e If there is not an icon on the desktop, follow this path:
Start > All Programs > Sage > MyAssistant (folder) > MyAssistant

When the User Configuration Manager is open, refer to Chapter 4 to activate the MyAssistant
workstation.
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Chapter 7 — Frequently Asked Questions

Installation

1.

10.

What version of MyAssistant needs to be installed?
The version that matches your primary version of Sage (i.e. the numbers before the first period in
the Sage version)

Does the MyAssistant Server need to be installed on the Sage 300 Server?
No

Does Sage need to be installed prior to installing MyAssistant?
Yes at least a Sage 300 workstation install

Will installing MyAssistant require a reboot?
Only if a prior software installation (e.g. a Windows Update) hasn’t completed and is waiting on a
restart

Does everyone need to be out of Sage to install MyAssistant?
No

Does Windows UAC need to be turned off on the MyAssistant server?
Yes

How do you turn off Windows User Account Control (UAC) in the registry?

Click the Windows Start button, type “regedit” in the search bar and select it from the list.
Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Policies\System. Double-click on “EnableLUA” and change the value from 1 to 0.

Do | need to let MyAssistant install an instance of MS SQL Server Express?
Yes, unless a full version of SQL Server has been purchased and will be used.

How do | know if the SQL Server installed on server is the Full or Express Edition?
You cannot determine the SQL Server Edition (Full or Express) from the software listed the
Programs and Features window.

Check to see if SQL Server Management Studio is installed. If it isn't, it is HIGHLY unlikely that a
full version of SQL is installed given that SQL Server Management Studio is installed with full
SQL.

Perform the following if SQL Server Management Studio is installed:
e Start SQL Server Management Studio
e Connect to the SQL Instance that you think is the full version
e Click the New Query button
e Type Select @@version and click [Execute]
e Expand the column width in the query results and look for the word “Express”

Where do | look for more information if something goes wrong when installing MyAssistant?
Click the Windows Start button, type “Event Viewer” in the search bar and select the program
from the list. Expand “Windows Logs” and select Application. Look for any entries with
“MyAssistant” under the Source column.
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11. What are common causes of the 1603 install error?
a. The folder that you are trying to install is encrypted.
b. The drive that contains the folder that you are trying to install the Windows Installer
package to is accessed as a substitute drive.
¢c. The SYSTEM account does not have Full Control permissions on the folder that you are
trying to install the Windows Installer package to. The Windows Installer service uses the
SYSTEM account to install software

Configuration

1. What are common reasons MyAssistant fails to activate?
e Incorrect Customer number or Product Key
e Firewall (software or hardware)
o Add the “Innovative Software Design” folder and all its subfolders in Program
Files (x86) to the Firewall Exceptions / White list
e Antivirus software
o Add the “Innovative Software Design” folder and all its subfolders in Program
Files (x86) to the Anti-virus Exceptions or White list
o Ifindividual files must be selected:
- MyAssistant.exe, MyAssistantConfigurationManger.exe, TaskRunner.exe and
ReportRunner.exe at C:\Program Files (x86)\Innovative Software Design\My
Assistant
- ISDAdminService.exe at C:\Program Files (x86)\Innovative Software Design\My
Assistant\SenderService
- ISDAdminService.exe and TaskRunner.exe at C:\Program Files
(x86)\Innovative Software Design\My Assistant\TaskService
¢ Windows UAC is enabled
e Server has been activated with another Windows user account

2. What are some of the reasons that I'm unable to logon to SQL server the first time through the
MA Server Configuration?
o MyAssistant is unable to create a SQL Server user because doesn’t recognize the logged
on user as having administrative privileges
e Incorrect TCP port or a dynamic port is specified in the

3. Why am | receiving an “...unable to write to database...” error?
See reasons for not being able to log onto the SQL Server database.

4. Which Sage User should be used in the Server configuration?
One with Application-level privileges to the data you want to access with MyAssistant and a
password set to never expire.

5. Does MyAssistant use a Sage license?
No

6. What are the names of the MyAssistant Windows Services?
MyAssistant uses two Windows Services to run Task, generate reports that are attached to email
messages and send email messages. The MyAssistant services are:
e |ISDAdminTaskService
e |ISDAdminSenderService
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Conclusion
This completes the initial setup of the Sage 300 CRE MyAssistant software. The next step is to activate or

create MyAssistant Tasks to begin monitoring your business. Please refer to the User Guide for information
on using MyAssistant.
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